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0 Copyright

Copyright

Software licence agreement

Rohde & Schwarz grants you the right to install the R&S Waveform Composer software on one or
more PCs of your choice. The licence included in the software package is linked to 5 serial numbers of
the arbitrary and function generators R&S AM300 selected by you, and allows you to transmit
waveforms created with the R&S Waveform Composer software to those instruments. A further licence
is required for each additional arbitrary and function generator R&S AM300 to which it is intended to
transmit waveforms.
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1  Introduction

1.1  Range of Applications
Introduction The "Waveform Composer" software for PCs is used for creating and

managing arbitrary waveforms within a Windows NT, 2000 or XP operating
system. These waveforms can be defined with the aid of appropriate
mathematical functions or point-by-point. Two waveforms can be edited and
displayed at the same time.

At the press of a button you can export the waveforms you have created, or
use them to control the arbitrary and function generator R&S AM300.

Software integration The PC software can be started independently, or via the remote-control
software on the R&S AM300. The export function processes the waveforms
according to the specification of the R&S AM300 and transmits the waveforms
and/or their parameters to the generator via the USB.

1.2  Accessories Supplied
Contents 1 USB cable

1 manual in English and German

1 CD (contents:   Manual in English and German,
      Waveform Composer software for PC,
      Acrobat Reader)
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2  Installation and Configuration

2.1  Installing the PC Software

���� Hinweis To install the PC software, you must have administrator rights on your PC. (�
Windows help).

The <Back> button enables the user to go back one step during installation.
Installation can be interrupted by pressing <Cancel>.

Installation steps 1. Place the CD ROM, which came with the product, in your installation
drive. The autorun function automatically initiates installation. Alternatively
you may also initiate the installation in the start menu of Windows
Start\Run using the Setup.exe from the CD.

The installation is prepared and the installation wizard appears.
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2. Click <Next> to continue the installation.

3. Click <Browse> to assign a new directory if you wish to install the
program in another directory than proposed. Click <Next> to continue the
installation.
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4. Click <Next> to continue the installation. Installation begins and the data
are transferred to the PC.Please wait a moment.

5. Click <Finish> to successfully complete the installation.

6. Depending upon the system configuration, you may be prompted to
restart your PC. Click <Yes> to restart the computer.

All new settings are now effective and the following appears in the
Windows Start\Programs\Rohde & Schwarz\Series300 start-up
menu:
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2.2 Registering the PC Software

Introduction The Waveform Composer software for PCs offers you the opportunity to
transmit generated waveforms to a arbitrary and function generator R&S
AM300. This can be done either with the aid of a USB stick or by using the
R&S AM300-K1 software for PCs (� R&S AM300 Operating Manual).

Before you can transmit waveforms from the Waveform Composer software
to a specific arbitrary and function generator R&S AM300, you must enable
the instrument concerned. When you purchased the Waveform Composer
software you acquired a licence allowing you to enable a maximum of five
R&S AM300 generators. If you wish to enable additional instruments you
require a new licence (for a further five instruments). You only need to install
the Waveform Composer software once.

There are five registration numbers on the back of your operating manual. To
enable an instrument simply send in one of these numbers with the serial
number of the instrument concerned. You will then receive an installation key.
You can use the installation key and the R&S AM300-K1 software (remote
control) to carry out the enabling procedure.

2.2.1  Requesting an Installation Key for the R&S AM300

How to make your
request

To obtain an installation key (also called a key code), please send the
following information to:

registration.smart-instruments@rsd.rohde-schwarz.com

� Your company address, e-mail address and telephone number
� The type and serial number of the instrument (e.g. R&S AM300, 123456)
� A software registration number (� back of operating manual)

Note: If you would like more than one key code, please send the serial
numbers of all the instruments concerned together with a registration number
for each (up to a maximum of five).

How we reply When we receive your information we shall immediately send you the key
code for the enabling procedure.

Note: If it is not possible for you to receive key codes by e-mail, or if you have
any specific inquiries, please contact your dealer or your nearest Rohde &
Schwarz office. The addresses of Rohde & Schwarz offices can be found in
the R&S AM300 Operating Manual.
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2.2.2  Enabling an Instrument

���� Note Before you can enable a arbitrary and function generator R&S AM300, you
must have installed and authorized the associated PC-based software R&S
AM300-K1 for instrument remote control (� R&S AM300 operating manual).

In order to start the Series 300 Software Manager it is important to close any
other Series 300 programs (such as AM300-K1, SM300-K1, AM300-K1).

Introduction When you have installed the Waveform Composer software you will find the
following entries under Start\Programme\Rohde & Schwarz\Series300 in
the Windows Start menu:

You can use the service program Series 300 Software Manager to enable
the Waveform Composer software for five arbitrary and function generators
R&S AM300.

Starting the service
program

1. Close all Series 300 programs (e.g. FS300-K1, SM300-K1, AM300-K1).

2. In the Windows start-up directory select:
Start\Programs\Rohde & Schwarz\Series300\Series 300 Software
Manager

The service program initializes. The program interface is divided into two
areas:

I    A list of all previously connected Smart instruments
II   Information, status fields and command buttons for authorization
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Entering the key
code

3. In I click on the instrument for which you wish to enter the key code.

In II the authorization information is displayed:

(a)    Current instrument information
(b)    Instrument status

III
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4. Click on <Authorization>. The entry field for the key code opens.

5. Enter the key code and click <OK>. If the key code has been entered
correctly, the instrument status in II changes from � to �.

Click on <Exit> in II in order to close the service program.

You can now start the Waveform Composer program and load
waveforms into the instrument you have enabled.

���� Note Once an instrument has been enabled it cannot be replaced by another, since
a key code can only be issued once.

a

b
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2.3  Starting the PC Software

2.3.1  Starting the Program

Starting the program • In the Windows Start menu click on:
Start\Programme\Rohde & Schwarz\Series300\Waveform Composer

The program starts and you can begin creating and editing waveforms.

Current defaults
are loaded

When you start the program a new session opens automatically and the
settings that were active at the time of the last exit from the program are
loaded again.

When you start the program for the very first time a factory default is active.

Note: It is also possible to set the configuration so that the most recently used
file is loaded (� 5-28).

2.3.2  Closing the Program

Closing the program • In Windows click on the close symbol x.

You may also select the option Exit in the pull-down menu File.
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2.4 Uninstalling the PC Software
Installation steps for
Windows 2000

1. Place the CD ROM, which came with the product, in the installation drive.
The autorun function automatically initiates installation. Alternatively you
may also initiate the installation in the start menu of Windows Start\Run
using the Setup.exe from the CD. The uninstallation is prepared and the
uninstallation assistant appears.

2. Click <Next> to continue the uninstallation.

3. Click <Finish> to complete the uninstallation.

���� Note The PC software can also be uninstalled using the Windows control panel.
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3  Getting Started

3.1  Editing a Waveform
Follow these steps 1. Open the File menu – create a new waveform e.g. New

2. Open the View menu – select a view e.g. Complete Waveform

3. Open the File menu – open Configuration

4. Select a tab e.g. Channel 1

5. Set the sample rate e.g. 100000
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6. Specify maximum number of samples e.g. 100000

7. Set the output voltage limits with
Voltage - Maximum/Minimum e.g. +5 V / -5 V

3.2  Editing a Segment
Follow these steps 1. Select a segment e.g. Segment 1

2. Enter the waveform duration e.g. 100 ms

3. Adjust the number of samples for the segment e.g. 10000

4. Enter a name for the segment e.g. S1
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3.3  Editing a Component

3.3.1  Set Vector Format Parameters

Follow these steps 1. Open the View menu – select a view e.g. Single Component

2. Select the first component e.g. Select from list

3. Select a waveform e.g. Sinusoid

4. Select a function e.g. Add

5. Set parameters e.g. 1000 Hz, 4 V, 0°, 1 V

6. Enter the name of the component e.g. C1
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7. Create second component    e.g. open Edit menu - New Component

8. Select second component e.g. Select from list

9. Select a waveform e.g. Triangular

10. Select a function e.g. Multiply

11. Set parameters e.g. 20 Hz, 2 V, 0°, 0 V, 50 %

12. Enter the name for the component e.g. C2
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3.3.2  Drawing in Draw Format

Follow these steps 1. Select a component e.g. Second Component

2. Convert the component e.g. open Edit menu
to Draw format         Component To Point

3. Press the Paintbox button

4. Press the Pen button

5. Use the pen to change the waveform (hold down the left mouse button
and draw over the waveform)

6. Press the Pen button again to close the Paintbox
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4  Operating Concept

4.1  Structure of the Program Interface
Control elements The program interface consists of various control elements, including those

which deal with viewing and editing, and is divided into the following areas:

a Pull down menu
All control functions are structured in menu functions

b Toolbar
Tool kit for the major functions

c Waveform parameters
Important waveform parameters

d Segment parameters
All the parameters of the selected segments

e Component parameters
All the parameters of the selected component

f Waveform information
Important information about the view and the waveform

g Waveform graph
For representing the waveform in one or two displays.

14

a

b

g

f

c

d

e



Selecting Functions PC Software R&S Waveform Composer

E-1008.0358.44 4-22 Operating Manual, 2/2004

4.2  Selecting Functions
Operating and
display functions

� You can use the pull down menu to access all the operating and display
functions. Selecting a function immediately triggers an action or opens a
dialog box which can be used to define further parameters.

� Most functions also have a key combination known as a hot key to speed
up processing, e.g. for saving:

Ctrl+S

� For quick and easy operation the mouse can be used with the Toolbar.

Specific
parameters

Specific parameters for segment functions and component functions are set
directly into entry fields and selection fields, e.g. for selecting the waveform.

Drawing
waveforms

Waveforms can be drawn one point or one stroke at a time by selecting the
component function Draw and its associated tools.
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4.3  Overview of Functions

4.3.1  Pull Down Menus

4.3.1.1  File

Function Shortcut Toolbar

Begin new session (� 6-40)

Open stored session (� 6-40)

Save current session (� 6-40)

Save current session as (� 6-40)

Set up page for printing (� 6-41)

Print active window (� 6-41)

Display information on waveforms (� 6-40)

Set system configurations (� 5-26)

Exit program

Display of files last used

4.3.1.2  Edit

Function Shortcut Toolbar

Cut segment or component (� 7-42)

Copy segment or component (� 7-42)

Insert segment or component (� 7-43)

Delete segment or component (� 7-43)

Delete clipboard contents (� 7-43)

Insert new segment (� 5-30)

Insert new component (� 5-33)

Convert waveform from vector format to points (� 7-44)

Convert segment from vector format to points (� 7-44)

Convert component from vector format to points (� 7-44)

Import waveform (� 7-45)

Export waveform (� 7-48)
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4.3.1.3  View

Function Shortcut Toolbar

Show display 1 (� 8-49)

Show display 2 (� 8-49)

Show displays 1 and 2 at the same time (� 8-49)

Display complete waveform and all segments (� 8-49)

Display selected segment (� 8-49)

Display selected component (� 8-49)

Open the Marker menu (� 8-50)

Display the points on the X scale (� 8-51)

Display the time domain on the X scale (� 8-51)

4.3.1.4  ? Help

Function Shortcut

Call help on the program (� 9-52)

Display program information (� 9-52)

4.3.2  Toolbar

Function 

Begin new session (� 6-40)

Open stored session (� 6-40)

Save current session (� 6-40)

Print active window (� 6-41)

Cut segment or component (� 7-42)

Copy segment or component (� 7-42)

Insert segment or component (� 7-43)

Insert new segment (� 5-30)

Insert new component (� 5-33)

Show display 1 (� 8-49)

Show display 2 (� 8-49)

Play back waveform as sound
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5  Creating a Waveform

5.1  Waveform Parameters

5.1.1  Structure of a Waveform

Main structure A waveform is a signal sequence consisting of one or more segments. The
segments are set to follow one another consecutively.

A waveform can consist of up to 262144 points (samples) and is displayed as
a curve of points. Once defined, a waveform can be managed with the aid of
various functions (Open, Save, Import, Export etc.) and be functionally
extended (New Segment etc.).

Parameter
dependencies

The maximum samples in a waveform must be specified in advance within the
configuration. Configuration defaults set limits on the parameters in the
Duration and/or Samples ranges. These two parameters interact with one
another. This also affects Start Phase or Start Samples. These parameters do
not cause any change in the display, but are calculated as appropriate during
an Export. Other configuration settings for a waveform are Sample Rate,
Sample, Resolution, Autoscale and Maximum/Minimum.

Waveform

1. Segment 2. Segment
2.1. Component

3. Segment
3.1. Component

4. Segment
4.1. Component

3. Segment
3.2. Component

3. Segment
3.3. Component

2. Segment
2.2. Component

4. Segment
4.2. Component

Maximum Samples

Total Duration



Waveform Parameters PC Software R&S Waveform Composer

E-1008.0358.44 5-26 Operating Manual, 2/2004

5.1.2  Configuring a Waveform

Ways to select the
setting window

� Configuration submenu in the File pull down menu

� Hot key combination Ctrl+G

5.1.2.1  Channel 1

Setting parameters
for channel 1

Sample Rate Specifies the sample rate for the R&S AM300

Maximum Samples Maximum number of samples for channel 1 (2)

2n When enabled, samples are entered in binary steps

Resolution Resolution of the DAC

Voltage Autoscale (on)
output values are normalized so that the peak amplitude value fully modulates
the DAC

Autoscale (off)
the amplitude that is output is the same as the values displayed in the
graphical window

Maximum Display range maximum

Minimum Display range minimum

���� Note Autoscale has no effect on the display. This function uses the whole range of
the DAC and improves the dynamic range of the D/A converter.
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5.1.2.2  Channel 2

Setting parameters
for channel 2

���� Note Parameters are set as in channel 1.

The parameters (other than Sample Rate) can be set separately for both
channels. Although the Sample Rate can in fact be set individually, it always
applies to both channels.

5.1.2.3  Colours

���� Note The colour setting always applies to both displays and to the current program
interface.

Colour setting

Plot Waveform colour

Plot Highlighted Colour of the waveform to be edited in "Single Component" view

Plot Background Background colour of display

Plot Selection Colour of the segment selection in "Complete Waveform" view

Grid Grid colour

Marker Marker colour

Panel Background Background colour of panel
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5.1.2.4  Miscellaneous

Setting and
managing specific
configurations

History The number of files you wish to store in the History list

Continue with last file The most recent file in the History list will be loaded on starting the program

Load... Open and update configuration files

Save... Save configuration files
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5.1.3  Displaying the Parameters

Waveform
parameters

The parameters for the active waveform are displayed after selection. Sample
Rate has the same value for both waveforms.

Sample Rate Sample rate for the R&S AM300

Start Phase Start phase for the waveform

Start Sample Start samples for the waveform

Waveform
graph

Selecting and displaying the waveform:

� Two waveforms in two different displays

� One waveform in a single display

Waveform
information

Sample display Displays the maximum samples per channel (red means the maximum has
been reached or exceeded)

Display selection The whole waveform is displayed via "Complete Waveform"

Segment information Displays the waveform parameters (Begin, End, Length in time and samples)
for the selected segment
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5.2  Segment Parameters

5.2.1  Structure of a Segment

Main structure Segments are waveforms composed of mathematical (vectorized) or point
components. Components are interconnected via arithmetical functions. The
result of all the components is a segment.

Parameter
dependencies

Segments are defined by the number of samples or the duration of the
waveform. The ratio of the samples to the sample rate defines the duration of
the segment.

e.g. Duration [s] = Sample [n] / Sample Rate [Hz]

0.002 [s] = 10000 / 5000000 [1/s]

5.2.2  New Segment

Ways to insert
a new segment

� New Segment submenu in the File pull down menu

� Hot key combination Ctrl+G

� Toolbar 

Segment

3. Segment
3.1. Component (Sinusoid)

3. Segment
3.2. Component (Rectangular)

3. Segment
3.3. Component (Draw)

Samples

Duration

Addition

Multiplication
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5.2.3  Displaying the Parameters

Segment parameters

S1 (1024 Samples)
S2 (1024 Samples)

Segment display list:

First segment showing its name and number of samples
Second segment showing its name and number of samples

Name Name of segment

Duration Duration of segment

Samples Number of samples in segment

2n When enabled, samples are entered in binary steps

Waveform
information

Display selection A selected segment is displayed via "Single Segment".

Segment information Displays the waveform parameters (Begin, End, Length in time and samples)
for the selected segment

���� Note The number of samples for the complete waveform should always be a
multiple of 2n. This is the only way the waveform memory in the R&S AM300
can be kept full. Otherwise the unused memory area will be padded with
zeros.
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5.2.4  Adapting the Samples

For standard
components

When the samples for standard components are changed the waveform is
recalculated and displayed in its new form.

For Draw
components

When the samples for Draw components are changed a window is opened
offering different methods of adaptation.

C1 [Draw] Name of segment

Stretch/toss to fit Waveform is stretched and/or tossed

Resize (cut/fill) Waveform is cut and/or filled

Periodic resize Waveform is periodically filled
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5.3  Component Parameters

5.3.1  Structure of a Component

Main structure A component is a mathematical function or a point waveform which is defined
with the aid of parameters.

5.3.2  New Component

Ways to insert a
new component

� New Component submenu in the File pull down menu

� Hot key combination Ctrl+B

� Toolbar 

Component

Component

Waveform

Component

Function: +, -, /, *

Parameter
Frequency
Vpp
Phase
Offset
Duty Cycle ...
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5.3.3  Displaying the Parameters

Component
parameters

C1 [Add] Sinusoid
C2 [Multiply] Formula

C3 [Subtract] Draw

Component display list:

Component 1.1 showing its name, function and waveform
Component 1.2 showing its name, function and waveform
Component 1.3 showing its name, function and waveform

Name Name of component

Waveform Waveform selection for component

Function Mathematical operation for linking to components

Frequency

Parameters of the active waveform:

Frequency

Vpp Peak-to-peak voltage

Phase Phase

Offset Offset

Waveform
information

A selected component is displayed via "Single Component". The selected
component is highlighted in a different colour and can be edited.

 

���� Note In the case of Sinusoid, Rectangular, Triangular and Exponential waveforms
you can enter not only the frequency in [Hz] but also the periods [cycl].
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5.3.4  Editing a Component

Selecting a
component

Click in the Waveform selection field

Setting the
parameters

Click in the entry fields of the active waveform

5.3.4.1  Standard Waveforms

Waveform Parameters

DC Level Offset [V]

Sinusoid Frequency [Hz], Vpp [V], Phase [°], Offset [V]

Triangular Frequency [Hz], Vpp [V], Phase [°], Offset [V], Symmetry [%]

Rectangular Frequency [Hz], Vpp [V], Phase [°], Offset [V], Duty Cycle [%]

Sweep Start [Hz], Stop [Hz], Vpp [V], Offset [V]

White Noise Start [Hz], Stop [Hz], Vpp [V], Offset [V]

Exponential Frequency [Hz], V0 [V], Vinf [V], Tau [s]
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5.3.4.2  Formula Waveform

Introduction Formula node syntax is similar to a text-based programming language and
can be used within the Formula function.

Press the Change button in order to enter formulas. Functions can be nested
and may consist of multiple terms. The result is displayed as a graph.

Syntax Function Description

abs(x) Absolute value

acos(x) Inverse cosine

acosh(x) Inverse hyperbolic cosine

asin(x) Inverse sine

asinh(x) Inverse hyperbolic sine

atan(x) Inverse tangent

atanh(x) Inverse hyperbolic tangent

ceil(x) Round to + infinity

ci(x) Cosine integral

cos(x) Cosine

cosh(x) Hyperbolic cosine

cot(x) Cotangent

csc (x) Cosecant

exp(x) Exponential

expm1(x) Exponential (arg) – 1

floor(x) Round to – infinity
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Syntax Function Description

gamma(x) Gamma function

getexp(x) Mantissa & exponent

getman(x) Mantissa & exponent

int(x) Round to nearest

intrz(x) —

ln(x) Natural logarithm

lnp1(x) Natural logarithm (arg + 1)

log(x) Logarithm base 10

log2(x) Logarithm base 2

max(x,y) Max & min

min(x,y) Max & min

mod(x,y) Quotient & remainder

pi(x) Represents the value = 3.14159...

rand( ) Random number (0 – 1)

rem(x,y) Quotient & remainder

sec(x) Secant

si(x) Sine integral

sign(x) Sign

sin(x) Sine

sinc(x) Sinc

sinh(x) Hyperbolic sine

spike(x) Spike function

sqrt(x) Square root

square(x) Square function

step(x) Step function

tan(x) Tangent

tanh(x) Hyperbolic tangent
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5.3.4.3  Draw Waveform

The Draw function is selected in Waveform and offers various methods for
drawing one point or one stroke at a time.

When you select the Draw waveform (� 5-35) the toolbox is displayed. If you
then click the button you can use the various Draw functions. Always select
the current segment in "Single Component" view. You can then zoom (� 10-
55) the point waveform and draw it as required.

Draw – Pencil

When you click on the pencil, the range limits are adopted and zooming is no
longer possible. When you move the mouse over the display the coordinates
are adopted and displayed. You may then press your left mouse button and
drag the pointer over the display to begin changing the waveform one point
at a time. You stop making changes to the waveform when you release the
mouse button again. You can activate the creation of strokes (or lines) with
the aid of the Shift key. Simultaneously hold down the Shift key and the
mouse button to define the first point. Then drag the pointer across the display
to create a straight line which ends at the point where you release the Shift
key.

Draw – View

This button displays the results of the Draw function. Pressing the button
displays the point waveform and the results of the whole segment. If the
number of samples is large, this display can slow down the processing and
display of waveforms. To obtain faster processing you can first disable the
button or secondly reduce the range of the waveform (zoom,� 10-55).

Draw – Undo

Points drawn in the waveform are discarded when you use this button. Any
changes you made to the range are actually adopted when you deactivate the
pencil button. The selected waveform ranges are then inserted into the
segment and it is no longer possible to undo any previous actions. However,
the Undo function can cancel the changes if the pencil button is still active.

���� Note You can accurately determine and display a position by zooming (� 10-55) a
segment range. You can thus adapt the waveform with pinpoint accuracy.

The Zoom tool cannot be used once the Draw pencil has been activated, and
is therefore hidden. Thus you should define the zoom range before you draw.

The coordinates (X direction: Sample; Y direction: Voltage) are displayed
below the toolbox for guidance.
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6  Editing Data (File)

6.1  Internal File Format

Structure of the
internal file format

A special format has been chosen for backing up both waveforms. They are
stored as a binary file (*.amb).

The memory format contains a file header (file version, creation dates, user
name and comment) followed consecutively by the two waveforms, each with
a data header (Sample Rate, Resolution, Amplitude, Start Samples and Max.
Samples), as well as marker positions and waveform data.

The waveform data is vectorized in order to minimize the size of the saved file
and to enable individual components to be further edited.
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6.2  Managing Data

6.2.1  New

Function An empty waveform is loaded so that details can be added. If you have
changed the current waveform, you are asked whether you wish to save it.

6.2.2  Open...

Function Opens a stored or exported file in the internal format (binary *.amb) in both
channels. A file dialog box opens.

If you confirm the new file and have changed the current waveform, you are
asked whether you want to save it before loading the new file.

6.2.3  Save

Function The waveform currently displayed in both channels is saved in the internal
binary format under the file name shown in the menu bar. When the program
has just been started or New has been used, the Save function works like
Save As..., and a new file name is requested.

6.2.4  Save As...

Function The waveform currently displayed in both channels is saved in the internal
binary format under a new file name.

6.2.5  File Information

Function Displays information about a file. You may enter notes about the waveform in
the Comment box.
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6.3  Printing Data

6.3.1  Page Setup...

Function This function is used for specifying the print settings and the printer setup.

Print header A header showing the file name, program name, amendment date, printing
date and page number is added when a window is printed out.

Use default margins
from preferences

The printer adopts the default margin settings.

Custom margins User-defined margin settings are adopted.

6.3.2  Print Window...

Function The current window is printed out on the standard printer without further
questions.
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7  Editing a Waveform (Edit)

7.1  General Functions
Editing a segment or
component
according to choice

You can use the functions Cut, Copy, Paste and Delete on a segment or
component according to choice. When you select one of these submenus a
dialog window is displayed for you to make a choice. If you click OK your
choice is confirmed and the requested action is carried out. Cancel closes the
window and the action is not carried out.

Converting a
component
into a segment

By making separate choices of segment or component for Cut, Copy and
Paste you can convert a component into a segment.

7.1.1  Cut

Function The selected segment or component is cut, i.e. removed from the active
waveform and placed on the Clipboard.

7.1.2  Copy

Function The selected segment or component is copied to the Clipboard, but not
removed from the waveform.
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7.1.3  Paste

Function The contents of the Clipboard are inserted in the active waveform as a
segment or component, in each case directly after the selected segment or
component. The Clipboard itself remains unchanged by this action.

Paste segment as
new component

If a segment is pasted as a new component ("Cut/Copy segment", "Paste as
new component"), all components of the original segment are pasted into the
currently selected segment after the selected component.

Paste component
as new segment

If a component is pasted as a new segment ("Cut/Copy component", "Paste
as new segment"), a new segment consisting of the component held on the
Clipboard is pasted after the currently selected segment.

Cannot be executed When you first start the Waveform Composer or use "Clear Clipboard" the
Clipboard is empty. In this situation the Paste function cannot be executed.

7.1.4  Delete

Function The selected segment or component is removed from the active waveform.
The Clipboard remains unchanged.

7.1.5  Clear Clipboard

Function The contents of the Clipboard are deleted. If there is no longer enough free
RAM for other applications, this can be a useful way of reducing the amount of
memory required by the Waveform Composer.

7.2  Specific Functions

7.2.1  New Segment

Function A new segment is pasted after the selected segment of the active waveform.
Parameters can then be assigned to the segment.

7.2.2  New Component

Function A new component is pasted after the selected component of the active
waveform. The component can then be assigned parameters or can be
drawn.
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7.2.3  Converting Formats

From vector format
to Draw format

The following functions convert a waveform or part of a waveform from vector
format (mathematical calculation of the waveform sequence from parameters)
to Draw format (point-by-point definition of the waveform sequence). By this
method the calculation results are saved as a sequence of points in which the
interval between points is defined by the sample rate. Draw format is also
known as pixel format or point format, which is why these functions are
named "... to Point".

7.2.3.1  Waveform to Point

Function The complete active waveform is converted to Draw format. The waveform
then consists of just a single segment with one Draw component.

7.2.3.2  Segment to Point

Function The selected segment of the active waveform is converted to Draw format.
The segment then consists of just a single Draw component. All other
segments remain unaffected.

7.2.3.3  Component to Point

Function The selected component of the active waveform is converted to Draw format.
All other components remain unaffected.
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7.3  External File Formats

7.3.1  Import

Function Imported waveforms are inserted in the internal or external format. The
waveforms are uploaded in the form of a curve of points. They can be
changed on a pixel-by-pixel basis only.

Import file type At the start of the function you are asked to select the import file type. You can
then select the file.

Data formats AM300 binary file format

AM300 ASCII file format

WinIQSIM import file *.ibn

MatLAB single ASCII files

MatLAB mixed ASCII file

MatLAB single binary files

MatLAB binary

MathCAD single files

MathCAD mixed file

DaDisp single files

DaDisp mixed

Cosap single files

Cosap mixed file
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SPW single ASCII files

SPW mixed ASCII file

SPW mixed binary file

ADS single ASCII files (cf. SPW)

ADS mixed ASCII file (cf. SPW)

WAVE format, 8-bit or 16-bit stereo

LeCroy Scopes binary 8-bit or 16-bit format

ASCII file format generated by IQSIM

Binary file format for I and Q

16-bit binary format for direct AMIQ drive

AWG2000 Arbitrary Waveform Editor format

IQW mixed file

AM300 instrument-specific format for enabled instrument

Specifying the path
for the import file

In the case of mixed file formats the I and Q vectors are held in one file only.
Specify the path for this file.

In the case of single file formats the I and Q vectors are held in two separate
files. Specify the paths for the I vectors and Q vectors separately.
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Pasting a
waveform

When the file has been loaded, a selection window for pasting the waveform
is displayed. The data to be pasted is shown as a separate graphic for each
channel.

The following options are available for pasting waveforms:

Do not import this channel

Import channel 1 (or 2) as a complete waveform

The current waveform will be overwritten

Import channel 1 (or 2) as a segment

In this case it is important to decide on the current segment after which the
new segment has to be loaded.

Import channel 1 (or 2) as a component

In this case it is important to decide on the current segment in which the new
component has to be loaded.
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7.3.2  Export

Export file type Exported waveforms are saved in the internal or external format. The
waveforms are output in the form of a curve of points. When they are read in
they can be changed on a pixel-by-pixel basis only.
At the start of the function you are asked to select the export file type. You can
then select the file. If you chose a "mixed" format, only one file selection box is
displayed. In the case of single files, two dialog boxes appear one after the
other. If the second file has the same name as the first, a warning message is
displayed.

Data formats � Import data formats, 7-45
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8  Adapting the Active Window (View)

8.1  Displays
Introduction The following functions define which waveform is visible. If only one waveform

is visible, it automatically becomes the active waveform, i.e. this waveform is
changed by subsequent edit functions (e.g. New Segment).

8.1.1  Display 1

Function Waveform 1 is visible and active, waveform 2 is hidden.

8.1.2  Display 2

Function Waveform 2 is visible and active, waveform 1 is hidden.

8.1.3  Display 1&2

Function Both waveforms are shown. The waveform that was active is still active. If you
want the other waveform to be active, you can use button 1  or 2  in the
toolbar.

8.2  Displaying a Waveform
Introduction The following functions define which part of a waveform is visible. If both

waveforms are visible, the functions affect both waveforms in the same way.

8.2.1  Complete Waveform

Function The complete waveform is displayed. The selected segment of the active
waveform is highlighted with the "Plot Selection" colour.

8.2.2  Single Segment

Function The selected segment is displayed.

8.2.3  Single Component

Function The selected segment is displayed in the normal plot colour and the selected
component is displayed using the "Plot Highlighted" colour.
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8.3  Markers
Function A separate marker trace can be defined for each waveform and is used to

synchronize other signal sources.

8.3.1  Editing Markers

Calling the
marker list

To configure the markers, select submenu View → Edit Marker. The display
now changes to the "Display 1&2" mode. The markers of the waveform
concerned are displayed in the work area together with their state (high, low).
In the case of a newly created waveform the list is empty.

To exit the marker list, click the OK button at lower right.

8.3.1.1  Adding Markers

Adding markers
to the list

To add a marker, click on the  button. If the marker list is empty, the marker
is inserted at the beginning of the waveform. If the list already contains
markers, the new marker is inserted at the next available position in relation to
the currently selected marker. The state of a newly inserted marker is always
LOW.

Inserting markers
in the graph

It is also possible to place new markers directly in the graph. Move the mouse
pointer to one of the two border markings on the scale. The pointer changes
to a positioning arrow. You can then hold down the mouse button and drag a
new marker to the desired position.
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8.3.1.2  Configuring Markers

Editing markers
in the list

If you want to change the position or state of a marker, select the marker
concerned from the list. The position and present state of the marker are now
shown in the entry field below the list. If you enter a new value in the Sample
Index box or change the State box, the marker list is updated.

Repositioning a
marker in the graph

You can also position a marker in the graph itself. Click on the marker in the
scale area, hold down the mouse button and drag the marker to the desired
position.

To position the marker with greater accuracy you can zoom (� 10-55) any
area of the graph. The X scroll bar appears so that you can still access all the
samples in the graph.

You can finely adjust the marker setting in the Sample Index entry field.

���� Note If you place a marker on an existing marker, the latter is overwritten by the
current marker.

8.3.1.3  Deleting Markers

Deleting markers To remove a marker from the list, highlight the relevant list entry. Then click
on . This updates the marker list.

8.3.2  Displaying Markers

Displaying markers
in the graph

When the marker list (� 8-50) is open, markers are shown in the appropriate
display together with their state.

In order to view markers when the marker list is closed, select submenu View
→ Show Marker.

8.4  X Scale
X scale: Samples For displaying the X scale in samples

X scale: Time For displaying the X scale in time domain

8.5  Zero Line
Zero Line For displaying a zero line
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9  Starting Help (?)

9.1  Help
Starting help Acrobat Reader (� CD-ROM) starts and the R&S AM300-K2 operating

manual opens.

9.2  Info
Displaying the
program version

An information field is displayed.

The information field automatically closes after about 10 seconds.
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10  Adapting the Waveform Graph

10.1  Waveform Display
Structure of the
waveform display

The display shows the complete waveform or individual segments as a plot.
Within this display all points on the waveform or segment are depicted without
compressing or adapting the pixels to the size of the screen. Areas of the
screen can be zoomed and displayed with pinpoint accuracy.

1 Plot The waveform as depicted in the display

2 Plot Highlighted A specific display form which is possible in "Single Component" view only and
highlights the waveform to be edited

3 Plot Selection Highlights the selected segment

4 Grid Grid over the display, used for guidance or to divide up the waveform

5 Marker Markers are displayed after switching to the appropriate display.

6 X Scale Scale showing the starting and final values of the samples or time domain

7 Plot Background Background colour for the display

8 Y Scale Scale for displaying voltage values

9 Plot Settings Plot settings (� 10-54)

10 Zoom Settings Zoom settings (� 10-55)

1

2

5

3

4

10

9

8

7

6
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10.2  Adapting the Display

10.2.1  Plot Settings

Application The graph uses a standard setting for each plot. This plot setting can be
changed and adapted via a setting menu.

Note: The plot setting is volatile and therefore retained for one session only.

Plot settings The Common Plots submenu helps you configure one of six commonly used
plot settings. These include a scatter diagram, a bar graph and a diagram of
the "fill to zero" type. The point, line and fill settings in the palettes for these
submenus are preconfigured.

The Colour submenu displays the palette for selecting the plot colour.

The Line Style, Line Width and Point Style submenus display settings that
can be used to differentiate a plot. The palette in the Line Width submenu
contains widths starting from the default setting of 1 pixel upward, including
hairline width. The latter option has no effect on the screen display, but prints
out as a very thin line provided the printer and printing mode support hairline
printing.

The edges of the waveform can be smoothed using the Anti-Aliased
submenu.
The Bar Plots submenu provides a selection of vertical bars, horizontal bars
and display without bars.

The Fill Base Line submenu defines how far from the base line the display
will be filled. Zero fills from the plot as far as a base line generated at 0.
+Infinity fills from the plot to the positive edge of the graph. -Infinity fills from
the plot to the negative edge of the graph. You can use the lower section of
this menu to select a specific plot within the graph, marking how far you wish
the display to be filled.

The Interpolation submenu calls a palette from which you can select various
point links or choose how the graph will draw lines between plotted points. In
the first option no lines are drawn, making this ideal for a scatter diagram. The
option at lower left draws a straight line between plotted points. The two
stepped options, in which points are linked by lines bent at a right-angle, are
useful for creating plots of the histogram type. The option at upper right plots
in the Y direction first, and the option at lower right plots in the X direction first.

The X/Y Scale submenu displays the names of the X/Y scales in the graph.
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10.2.2  Zoom Settings

Zoom functions The waveform graph provides a palette for setting the zoom area. You can
select the zoom functions from a popup menu. Sections of the graph can be
enlarged or reduced.

When you have selected the Zoom function, you can use the mouse to define
the zoom area in the display.

Opens the selection window

Enlarges the highlighted area in the X and Y directions

Enlarges the highlighted area in the X direction only

Enlarges the highlighted area in the Y direction only

Cancels the last zoom operation and resets the graph to the previous setting

Enlarges the graph in the X and Y direction at the highlighted position

If you hold the mouse button down at a particular point, the graph continues to
be enlarged until you release the button again.

Reduces the graph in the X and Y direction at the highlighted position

If you hold the mouse button down at a particular point, the graph continues to
be reduced about this point until you release the button again.

Resets the zoom area
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11 Index
11.1 Index
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Complete Waveform ................................... 8-49
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View (pull down) ......................................4-24

Miscellaneous, configuration .......................5-28
Monitor (display) ..........................................4-21

N
New .............................................................6-40
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Save ............................................................ 6-40
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Scaling ........................................................ 8-51
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structure .................................................. 5-30
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